
$1#2K3

{bmc PRODUCT-SMALL.BMP}

About InterNova

InterNova provides internet and intranet solutions for business, specializing in 
internetworking, application development, and website assembly.

For more information, contact us at:

InterNova Corporation
15 Franklin Street
Westport, CT 06880

phone: (203) 454-4802
fax: (203) 454-221-9019
tollfree: (888) NETKITS

Email: sales@internova.com
WWW: http://www.internova.com
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$4#5K6Applying a Profile to Netscape

To make use of a NetWiz profile for changing Netscape's current preferences, follow these steps:

1) Open NetWiz.
2) Select the desired profile from the NetWiz profile list.
3) Click the "Apply to Netscape" button in the toolbar.
4) Launch Netscape.

Note: You can also set NetWiz Options so that Netscape launches automatically upon clicking the "Apply 
to Netscape" button (see Launching Netscape from NetWiz).
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$7#8K9Changing the Default Profile Settings:

When creating a new profile, you will find that NetWiz saves several of Netscape Navigator's default 
directory and file settings as default profile settings, as listed below:

In NetWiz "General" settings, you will see:

Bookmark File:
C:\Program Files\Netscape\Navigator\Bookmark.HTM

Address Book:
C:\Program Files\Netscape\Navigator\Address.HTM

Cache Directory:
C:\Program Files\Netscape\Navigator\Cache

History File:
C:\Program Files\Netscape\Navigator\Netscape.hst

In NetWiz "Mail" settings, you will see:

Default Mail Directory:
C:\Program Files\Netscape\Navigator\Mail

Default Mail File (Mail FCC):
C:\Program Files\Netscape\Navigator\Mail\Sent

In NetWiz "News" settings, you will see:

Default News Directory:
C:\Program Files\Netscape\Navigator\News

Default News File (News RC):
C:\Program Files\Netscape\Navigator\News\news.rc

These pathnames represent files and directories that were create on your hard drive when Netscape 
Navigator was installed. You may wish to change some or all of these particular settings in your profile so 
that the paths point to other files or directories. For example, in a shared computing environment, you 
may want to save separate Bookmark or Address Book files (stored elsewhere), so that your address and 
bookmark entries are kept distinct from another user's. To change any of the default settings listed above, 
follow the instructions below.

To change a setting that points to a default file:

(1) Select the "Browse" button that appears next to the field that you want to modify.
[A pop-up window will appear that will allow you to specify the file that you want to point to.]
(2a) If the file already exists, select the file from the pop-up window.
Otherwise...
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(2b) If the file doesn't exist, select the location where you want to create a new file, then enter a name for 
the file (in the pop-up window).
(3) Click the "Open" button in the pop-up window and, if it is a new file, click "OK" at the prompt that will 
follow.
(4) Click the "Save" button in the toolbar.
(5) Select "Launch Netscape on Apply" from the "Options" menu (turns checkmark on).
(6) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.
[Upon launching Netscape from NetWiz, your changes will take effect.]

To change a setting that establishes a default directory:

(1) Select the "Browse" button that appears next to the field that you want to modify.
[A pop-up window will appear that will allow you to specify a directory path.]
(2a) If the directory already exists, select the directory path from the pop-up window.
Otherwise...
(2b) If the directory doesn't exist, select the location where you want to create a new directory, then enter 
a name for the directory (at the end of the pathname that appears in the pop-up window).
(3) Click the "OK" button in the pop-up window.
(4) Click the "Save" button in the toolbar.
(5) Select "Launch Netscape on Apply" from the "Options" menu (turns checkmark on).
(6) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.
[Upon launching Netscape from NetWiz, your changes will take effect.]

See also: Setting Preferences in a NetWiz Profile
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$13#14K15Creating a New Profile

To create a new profile, follow these steps:

1) Open NetWiz.
2) Click the "New Profile" button in the toolbar.
3) Enter a name for the new profile in the dialog box.
4) Click "OK."
[Settings that Netscape uses as default preferences* will automatically appear in various fields within the 
NetWiz tab folders.]
5) To change any of the default preference settings, see Changing the Default Profile Settings.
6) To be able to use Netscape Mail, see Setting the Basic Preferences Required for Using Netscape Mail.
7) To add additional settings, enter the settings as desired** (for more information, see Setting 
Preferences in a NetWiz Profile).
8) Click the "Save" button in the toolbar.

Note:

*The "default settings" include the settings for Bookmark File, Address Book, Cache Directory, History 
File, Mail Directory, Default FCC, News Directory, and News RC.
**You may want to read what we have to say about the "Remember Passwords" preference option in 
Security and Passwords.

You can also create a new profile on the basis of an existing one, by following these steps:

1) Open NetWiz.
2) Select the existing profile from the NetWiz profile list.
4) Choose "Save As" from the file menu.
5) Enter a name for the new profile.
6) Click "OK."
7) Then follow the instructions for Editing an Existing Profile.

See also: Editing an Existing Profile
Deleting a Profile
Setting Preferences in a NetWiz Profile

13$ Creating a New Profile
14# Creating_a_New_Profile
15K Creating a New Profile



$16#17K18Deleting a Profile

To delete a NetWiz profile, follow these steps:

1) Open NetWiz.
2) Select the desired profile from the NetWiz profile list.
3) Click the "Delete" button in the toolbar.

See Also: Creating a New Profile
Editing an Existing Profile
Setting Preferences in a NetWiz Profile
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$19#20K21Editing an Existing Profile

To edit an existing profile, follow these steps:

1) Open NetWiz.
2) Select the existing profile from the NetWiz profile list.
3) Enter changes into the tab folder fields as desired.
4) Click the "Save" button in the toolbar.

See also: Creating a New Profile
Deleting a Profile
Setting Preferences in a NetWiz Profile
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$22#23K24How NetWiz Works:

NetWiz works by taking advantage of how Netscape Navigator stores and reads a users preference 
settings. In Windows 95 and WindowsNT, much of what was accomplished previously with .INI files is 
now done through the Windows registry. Netscape Navigator's use of the Windows registry to store its 
preferences (instead of a .INI file) makes it difficult to use Netscape Navigator as a multi-user News, Mail 
or WWW client, since each set of preferences entered by a user overwrites the previous user's settings.

NetWiz solves this problem by storing multiple user profiles for Netscape Navigator preferences in a .INI 
file. Once NetWiz is configured, using it to start a session using Netscape Navigator is as easy as 1-2-3: 
(1) The user opens NetWiz, (2) highlights his or her pre-defined profile, and (3) clicks a button to launch 
Netscape Navigator with the user's own News, Mail, and WWW settings automatically loaded!
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$25#26K27Introduction

To get started quickly, follow the Quick Start instructions.
To take full advantage of the preference managing features of NetWiz, use the NetWiz Setup instructions 
instead.
To modify a profile after it has been set up, see Editing an Existing Profile.

See also: What is NetWiz?
How NetWiz Works
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$28#29K30Launching Netscape from NetWiz

To launch Netcape directly from NetWiz, follow these steps:

1) Open NetWiz.
2) Select "Launch Netscape on Apply" from the "Options" menu (turns checkmark on).
3) Select the desired profile from the NetWiz profile list.
4) Click the "Apply to Netscape" button in the toolbar.

Note: With the "Launch Netscape on Apply" option on, clicking the "Apply to Netscape" button in the 
toolbar applies the selected profile to Netscape's preferences and automatically launches Netscape.

See also: Applying a Profile to Netscape
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$31#32K33Managing Multiple Profiles for an Individual User:

NetWiz can be used by an individual user or by multiple users, on a single computer or on a Local Area 
Network. NetWiz has a number of ways to manage multiple profiles for an individual user, as indicated 
below:

To manage multiple profiles for an individual user on a single computer:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on the C drive (the default).
- The .INI File can be stored on a floppy disk.
- The .INI File can be stored on the local computer in your own personal hard drive space that is 

secure from others (e.g., via password protection).

To manage multiple profiles for an individual user on a Local Area Network:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on a secure drive assigned to you by your Network administrator. 

[Often in a Local Area Network, the system administrator assigns a particular drive mapping on a
server to be designated as a user's personal drive space. When the user logs on with a unique 
ID and password, there is a drive designation (for example, the H drive) that maps to that 
particular user's personal drive space (i.e, each user who chooses the H drive is accessing his 
or her own personal space). In this case, each user can maintain a separate NetWiz .INI file that 
stores his or her NetWiz profiles, and the default .INI file location for NetWiz can be set up just 
once (e.g., by choosing "H:\InterNova.INI").]

See also: Setting the .INI File Location
Security and Passwords
Managing Profiles for Multiple Users
Using NetWiz on a Single Computer
Using NetWiz on a Local Area Network

31$ Managing Multiple Profiles for an Individual User
32# Managing_Multiple_Profiles_for_an_Individual_User
33K To Manage Preferences for an Individual User



$34#35K36Managing Profiles for Multiple Users

NetWiz can be used by an individual user or by multiple users, on a single computer or on a Local Area 
Network. NetWiz has a number of ways to manage profiles for multiple users, as indicated below:

To manage profiles for multiple users on a single computer:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on the C drive (the default).
- The .INI File can be stored on a floppy disk.
- The .INI File can be stored on the local computer in your own personal hard drive space that is 

secure from others (e.g., via password protection).

See also Setting the .INI File Location and Security and Passwords.

To manage profiles for multiple users on a Local Area Network:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on a secure drive assigned to you by your Network administrator. 

[Often in a Local Area Network, the system administrator assigns a particular drive mapping on a
server to be designated as a user's personal drive space. When the user logs on with a unique 
ID and password, there is a drive designation (for example, the H drive) that maps to that 
particular user's personal drive space (i.e, each user who chooses the H drive is accessing his 
or her own personal space). In this case, each user can maintain a separate NetWiz .INI file that 
stores his or her NetWiz profiles, and the default .INI file location for NetWiz can be set up just 
once (e.g., by choosing "H:\InterNova.INI").]

See also: Setting the .INI File Location
Security and Passwords
Managing Multiple Profiles for an Individual User
Using NetWiz on a Single Computer
Using NetWiz on a Local Area Network
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$37#38K39NetWiz Setup

To take full advantage of the preference managing features of NetWiz, use the "NetWiz Setup" 
instructions below:
To get started quickly, follow the Quick Start instructions.
To modify a profile after it has been set up, see Editing an Existing Profile.

NetWiz Setup

1) Open NetWiz.
2) Click the "New Profile" button in the toolbar to create your first profile.
3) Enter a name for the new profile in the dialog box.
4) Click "OK."
[Settings that Netscape uses as default preferences* will automatically appear in various fields within the 
NetWiz tab folders.]
5) To change any of the default preference settings, see Changing the Default Profile Settings.
6) To be able to use Netscape Mail, see Setting the Basic Preferences Required for Using Netscape Mail.
7) To add additional settings, enter the settings as desired** (for more information, see Setting 
Preferences in a NetWiz Profile).
8) Click the "Save" button in the toolbar.
9) Select "Launch Netscape on Apply" from the "Options" menu (turns checkmark on).
10) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.

Notes: 

*The "default settings" include the settings for Bookmark File, Address Book, Cache Directory, History 
File, Mail Directory, Default FCC, News Directory, and News RC.
**You may want to read what we have to say about the "Remember Passwords" preference option in 
Security and Passwords.

Once you have saved one or more profiles and have set NetWiz Options to launch Netscape 
automatically, the next time you use NetWiz to apply a profile to Netscape, the process will be even 
quicker. Anytime you want to use Netscape in a shared computing environment (or when you maintain 
multiple profiles of your own), just follow these three simple steps:

1) Open NetWiz.
2) Select the desired profile from the NetWiz profile list.
3) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.
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$40#41K42Quick Start

To get started quickly, follow the "Quick Start" instructions below:
To take full advantage of the preference managing features of NetWiz, use the NetWiz Setup instructions 
instead.
To modify a profile after it has been set up, see Editing an Existing Profile.

Quick Start

1) Open NetWiz.
2) Click the "New Profile" button in the toolbar to create your first profile.
3) Enter a name for the new profile in the dialog box.
4) Click "OK."
5) Click the "Save" button in the toolbar.
6) Select "Launch Netscape on Apply" from the "Options" menu (turns checkmark on).
7) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.

Note: Once you have saved one or more profiles and have set NetWiz Options to launch Netscape 
automatically, the next time you use NetWiz to apply a profile to Netscape, the process will be even 
quicker. Anytime you want to use Netscape in a shared computing environment (or when you maintain 
multiple profiles of your own), just follow these three simple steps:

1) Open NetWiz.
2) Select the desired profile from the NetWiz profile list.
3) Click the "Apply to Netscape" button in the toolbar to launch Netcape automatically.

See also: NetWiz Setup
Editing an Existing Profile
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$43#44K45Saving a Profile

There are a few ways to save a profile.

To save changes to an already existing profile, follow these steps:

1) Open NetWiz.
2) Select the existing profile from the NetWiz profile list.
3) Enter changes into the tab folder fields as desired.
4) Click the "Save" button in the toolbar.

To save a new profile from scratch (before entering the desired settings), follow these steps:

1) Open NetWiz.
2) Click the "New Profile" button in the toolbar.
3) Enter a name for the new profile in the dialog box.
4) Click "OK."
5) Enter the desired settings into the tab folder fields.
6) Click the "Save" button in the toolbar.

To save a new profile on the basis of an existing one (after entering changes), follow these steps:

1) Open NetWiz.
2) Select the existing profile from the NetWiz profile list.
3) Enter changes into the tab folder fields as desired.
4) Choose "Save As" from the file menu.
5) Enter a name for the new profile.
6) Click "OK."

See also: Editing an Existing Profile
Deleting a Profile
Creating a New Profile
Setting Preferences in a NetWiz Profile
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$46#47K48Security and Passwords

In order to keep access to your e-mail account protected from unauthorized users, it is recommended that
you not choose the "Remember Password" option if you are sharing a computer with other users. 
Selecting this option could enable the next user of Netscape Mail to access your e-mail account 
(intentionally or not). This is true whether you have saved a separate .INI file to store your own profiles or 
not (see Setting the .INI File Location for more information on this). By not choosing the "Remember 
Password" option, you can protect access to your e-mail account and prevent its unauthorized use.

Though not required for using NetWiz, you may want to store your personal NetWiz profiles in a separate 
NetWiz .INI file (see Setting the .INI File Location). This will protect your profile from being lost (altered, 
deleted, overwritten, etc.). Several scenarios are possible:

- You can store the NetWiz .INI file on a floppy disk. See also Using NetWiz on a Single 
Computer and Managing Multiple Profiles for an Individual User.

- You can store the NetWiz .INI file on a local computer in your own personal hard drive 
space that is secure from others (e.g., via password protection). See also Using NetWiz 
on a Single Computer and Managing Multiple Profiles for an Individual User.

- You can store the NetWiz .INI file on a secure drive assigned to you by your Network 
administrator. 

 [Often in a Local Area Network, the system administrator assigns a particular drive 
mapping on a server to be designated as a user's personal drive space. When the user 
logs on with a unique ID and password, there is a drive designation (for example, the H 
drive) that maps to that particular user's personal drive space (i.e, each user who 
chooses the H drive is accessing his or her own personal space). In this case, each user
can maintain a separate NetWiz .INI file that stores his or her NetWiz profiles, and the 
default .INI file location for NetWiz can be set up just once (e.g., by choosing "H:\
InterNova.INI"). See also Using NetWiz on a Local Area Network, and Managing Profiles
for Multiple Users.

See also: How NetWiz Works
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$49#50K51Setting Preferences in a NetWiz Profile:

When creating a new profile, there are two types of NetWiz preference settings to understand: those that 
NetWiz initially provides default values for and those for which no default values are specified. The 
"default settings" include the settings for Bookmark File, Address Book, Cache Directory, History File, Mail
Directory, Default FCC, News Directory, and News RC. To change the default preferences you should 
read Changing the Default Profile Settings.

To correctly set preferences for the other fields, here are some examples and suggestions:

In NetWiz "General" settings:

Home Page: [Specifies the URL of a web page that will appear when you launch Netscape Navigator.]
example: http://www.internova.com

Bookmark File: [Read Changing the Default Profile Settings.]

Address Book: [Read Changing the Default Profile Settings.]

Cache Directory:[Read Changing the Default Profile Settings.]

History File: [Read Changing the Default Profile Settings.]

On Startup Launch: [Specifies which component of Netscape will open upon launching Netscape.]

Toolbar: [Specifies the display of the Netscape toolbar.]

In NetWiz "User" settings:

Reply To:[Specifies an address for receiving replies to the messages you send.]
example: jdoe2@internova.com

Signature File: [A .txt file that contains signature information that appends to the messages you send.]
example:

John Doe
jdoe@internova.com\
(800) 555-1234
____________________________

"The medium is the message."

Email: [Specifies your email address on the messages you send.]
example: jdoe@internova.com

Name: [Specifies your name on the messages you send.]
example: John Doe

Organization: [Specifies your organization on the messages you send.]

49$ Setting Preferences in a NetWiz Profile
50# Setting_Preferences_in_a_NetWiz_Profile
51K Setting Preferences in a NetWiz Profile



example: InterNova

In NetWiz "Mail" settings:

Username:    [Specifies the part of your email address to the left of the @ symbol.]
example: jdoe

SMTP Server: [Specifies the host name of your outgoing mail (SMTP) server.]
example: internova.com

POP Server: [Specifies the host name of your incoming mail (POP) server.]
example: internova.com

Mail Directory:    [Read Changing the Default Profile Settings.]

Default FCC:    [Read Changing the Default Profile Settings.]

Default CC: [Specifies an email address that will receive a copy of the messages you send.]
example: msmith@internova.com

Note: The "Remember Password" checkbox allows Netscape Navigator to remember your password so 
that the next time you open Netscape's Mail window, it will not prompt you for a password. In a shared 
computing environment, it is recommended that you do not choose this option (see Security and 
Passwords for more information).

In NetWiz "News" settings:

NNTP Server: [Specifies the host name of your news server.]
example: internova.com

News Directory:    [Read Changing the Default Profile Settings.]

News RC:    [Read Changing the Default Profile Settings.]

News CC: [Specifies an email address that will receive a copy of the messages you send.]
example: msmith@internova.com

In NetWiz "Proxies" settings:

No Proxy: [Choose to use a direct connection to the internet.]

Manual Proxy: [Choose to manually specify proxy settings for different servers (e.g., host names or IP 
addresses) and their port numbers.]

Automatic Proxy URL: [Choose to specify the URL of a proxy configuration file that a netwok administrator
has set up.]

No Proxy For: [Choose to bypass the proxy server for any local domain(s) that you specify.]

Note: More information on the functions of these preferences can be found in Netscape Navigator's 
Handbook under "Preferences Panels" (see Netscape's site at http://www.netscape.com for more 



information).



$52#53K54Setting the .INI File Location

Netscape Navigator's use of the Windows registry to store its preferences (instead of a .INI file) makes it 
difficult to use Netscape as a multi-user News or Mail client, since each set of preferences entered by a 
user overwrites the previous user's settings. NetWiz solves this problem by storing multiple user profiles 
in a .INI file. The location of the default .INI file ("C:\InterNova.INI") can be also be changed to suit 
different environments. To change the .INI file location, follow these steps:

1) Open NetWiz.
2) Select the ".INI File Location" from the "File" menu.
3) Enter a new path name in the "New .INI File Location" field.
4) If profiles already exist in the current .INI file location and you wish to preserve those in the file that is 
created in the new .INI file location, then click the "Copy Current File to New Location" checkbox. [Omit 
this step if you wish to create a new .INI file in the new location (without preserving existing profiles).]
5) Click "OK."

Since the .INI file location can be changed, it is also possible to have separate .INI files for each user. For 
example, by setting the .INI file location to the A: drive, each user can store his or her profile (or multiple 
profiles) on a personal floppy disk. Or on a Local Area Network, users can maintain a .INI file in a user-
assigned drive and can set the .INI file location accordingly, so that after a user logs on to the network, 
the .INI file called up when using NetWiz will be the user's own. Saving your profiles in your own .INI file 
will protect your profile from being lost (altered, deleted, overwritten, etc.). For more information on 
possible scenarios, see Managing Multiple Profiles for an Individual User and Managing Profiles for 
Multiple Users.

See also: How NetWiz Works
Security and Passwords
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$55#56K57Setting the Basic Preferences Required for Using Netscape Mail:

To be able to use Netscape Mail properly, you should follow these additional instructions:

Enter the following preference settings in NetWiz:

In the NetWiz "User" tab folder:

Email: Enter your email address.
example: jdoe@internova.com

In the NetWiz "Mail" tab folder:

Username: Enter your username (the portion of your email address that appears before the "@" sign).
example: jdoe

SMPT Server: Enter the name of your SMPT Server (consult your network administrator or internet 
service provider if needed).
example: internova.com

POP3 Server: Enter the name of your POP3 Server (consult your network administrator or internet 
service provider if needed).
example: internova.com
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$58#59K60Troubleshooting:

Q: I just installed Netwiz, setup a new profile, but I can't use Netscape's Mail client.

A: You probably set up your profile using the Quick Start instructions. Read NetWiz Setup, which refers to 
Setting the Basic Preferences Required for Using Netscape Mail.

Q: Can I use a two-word name for a profile?

A: Yes. In NetWiz 3.0, two-word names are permitted (an underscore is added automatically).
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$61#62K63Using NetWiz on a Local Area Network:

NetWiz can be used by an individual user or by multiple users, on a single computer or on a Local Area 
Network. NetWiz can be used on a Local Area Network as follows:

To manage profiles for multiple users on a Local Area Network:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on a secure drive assigned to you by your Network administrator. 

[Often in a Local Area Network, the system administrator assigns a particular drive mapping on a
server to be designated as a user's personal drive space. When the user logs on with a unique 
ID and password, there is a drive designation (for example, the H drive) that maps to that 
particular user's personal drive space (i.e, each user who chooses the H drive is accessing his 
or her own personal space). In this case, each user can maintain a separate NetWiz .INI file that 
stores his or her NetWiz profiles, and the default .INI file location for NetWiz can be set up just 
once (e.g., by choosing "H:\InterNova.INI").]

To manage multiple profiles for an individual user on a Local Area Network:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on a secure drive assigned to you by your Network administrator. 

[Often in a Local Area Network, the system administrator assigns a particular drive mapping on a
server to be designated as a user's personal drive space. When the user logs on with a unique 
ID and password, there is a drive designation (for example, the H drive) that maps to that 
particular user's personal drive space (i.e, each user who chooses the H drive is accessing his 
or her own personal space). In this case, each user can maintain a separate NetWiz .INI file that 
stores his or her NetWiz profiles, and the default .INI file location for NetWiz can be set up just 
once (e.g., by choosing "H:\InterNova.INI").]

See also: Setting the .INI File Location
Security and Passwords
Managing Multiple Profiles for an Individual User
Managing Profiles for Multiple Users
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Using NetWiz on a Single Computer



$64#65K66Using NetWiz on a Single Computer

NetWiz can be used by an individual user or by multiple users, on a single computer or on a Local Area 
Network. NetWiz can be used on a single computer as follows:

To manage profiles for multiple users on a single computer:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on the C drive (the default).
- The .INI File can be stored on a floppy disk.
- The .INI File can be stored on the local computer in your own personal hard drive space that is 

secure from others (e.g., via password protection).

To manage multiple profiles for an individual user on a single computer:

Getting Started:

- The user sets up each of his or her profiles following the "Getting Started" instructions (begin 
with the Introduction).

Setting the .INI File Location:

- The .INI File can be stored on the C drive (the default).
- The .INI File can be stored on a floppy disk.
- The .INI File can be stored on the local computer in your own personal hard drive space that is 

secure from others (e.g., via password protection).

See also: Setting the .INI File Location
Security and Passwords
Managing Multiple Profiles for an Individual User
Managing Profiles for Multiple Users
Using NetWiz on a Single Computer
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$67#68K69What is NetWiz?

NetWiz is a Netscape Navigator add-on (for Windows 95 and NT) that allows users to create and manage
multiple profiles for Mail, News, and other Navigator preferences. For users in a Local Area Network 
environment, NetWiz enables Netscape Navigator to be used as a multi-user Mail and News client.

Feature summary:

-Effectively converts Netscape Navigator into a multi-user Mail and News client that can be 
securely used on shared computers.

-Manages Mail and News preference settings using profiles for each user, allowing user-tailored 
access to these services from any computer over a Local Area Network.

-Allows an individual user who has multiple News and Mail accounts to maintain separate profiles
for each of the user's services.

-Enables users to keep their electronic mailboxes distinct, eliminating the problem of one user's 
mailbox becoming filled with another user's mail.

-Provides the ability to maintain separate WWW bookmarks, separate e-mail address books, 
separate newsgroup files, and separate default home pages for each user.

-Maintains separate profiles for Network Proxies preferences.
-Assures individual security across all of the above features.

If you're accustomed to using Netscape Navigator but need a solution that manages profiles for multiple 
services or multiple users on a shared computer or a local area network, NetWiz may be just what you're 
looking for.
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